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Conventions in the manual: 
 
1. Bluetooth and “BT” refer to the wireless communication between devices such as GPS and the XM 

radio. BT and Bluetooth may be referred to interchangeably. 
 
 
 
 

Please Note: This manual is in the process of being updated to match the new version of the software, 
which was a complete re-write from the prior. We apologize for this manual being incomplete. The content 
in it is, however, accurate and applicable to the new version and use of the Motion tablet computers. For 
updates to this manual, check out our website at www.anywheremap.com/documentation. 

 
 

Check out www.anywheremap.com/videos for more information and instructional videos!! 
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GETTING READY 
 
You will save yourself a bunch of time and frustration if you read this section BEFORE YOU DO 
ANYTHING! 
 
1. If you bought an entire system from us INCLUDING the Motion tablet computer, then we have 

installed the software on it, activated the XM radio (if you bought a weather system), connected the 
GPS and XM radio, configured the system, and tested it. There is nothing for you to do except: 

a. Register the software 
b. Follow the directions on the fold-out sheet that shows how to power up and install the system 

in the airplane. 
c. Do NOT perform the steps in Chapters 1 - 4.  
d. Use the remaining sections in this manual for reference.  

2. If you bought only the software from us or the software, GPS, and XM unit, then you must follow 
Chapters 1 – 4 completely.  

3. If you are a computer professional, you may know other ways to configure peripherals such as the 
GPS and XM unit. We strongly recommend you follow these instructions and resist the temptation to 
“ad-lib”.  

4. Once everything is installed and configured, be careful to follow the antenna placement instructions 
on the fold-out sheet that came in the documentation package. Antenna placement for the XM radio is 
CRITICAL to continuous successful operation. 
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1. SOFTWARE INSTALLATION 
 

!!! VERY IMPORTANT !!! 
IF YOU ARE USING THE TRACKER USB GPS, DO NOT ATTACH THE 

TRACKER USB GPS UNTIL AFTER THE SOFTWARE HAS BEEN INSTALLED! 
 
System Requirements – Windows PC with Windows 98, ME, 2000, XP or XP-Mobile; at least 200 MB 
spare storage space and at least 128 MB of memory recommended. 
 
1) Insert the AnywhereMap XP or AnywhereWx XP 

Software CD into you computer’s CD drive. When the 
installation window opens as shown at right, do the 
following in this order: 
a) Register the software: 

b) Click the “Registration” link 
i) If you already own other registered 

Anywhere products (i.e. Map, Wx, or 
Pocket Plates), then:  
(1) log in using your username and 

password and 
(2) verify the information displayed and  
(3) click Next. 

ii) If this is the first product you have ever registered with us, 
(1) click on Create a New User ID. 
(2) Fill out the information requested and 
(3) Click Next 

iii) Select the number that corresponds to the number of software products you’re 
registering. Click Next. 

iv) Carefully enter the software serial number from the sticker on the inside of the Anywhere 
XP software CD case (and also those from any other software CDs we sent you). The 
serial number is case sensitive so pay close attention to capitalization. Click Next. 

v) Confirm all the information and you’re done! Thanks for registering the software! 
b) Install the Software 

i) Click on Install AnywhereMap XP. 
ii) On the Next page (See right), click Install…. 
iii) The Setup Wizard begins. Simply click Next and follow the 

prompts for a Full Installation. Where the Databases are 
listed, leave them defaulted unless you live outside the 
lower 48 US states. Click Next. 

iv) The confirmation page confirms your selections. If all is acceptable, simply click Install. 
v) The GPS driver will be installed next. A window will pop up titled “Texas Instruments UMP 

Installation” telling you drivers need to be loaded and asking you to Accept the License 
Agreement for the drivers. Then click to Install. 

vi) The Windows Driver Installer will now open. If a Software Installation Warning pops up telling 
you that the software has not passed Windows logo testing, please click Continue Anyway. 

vii) Two USB drivers will be installed so you’ll go through this process (m & n) a second time. 
viii) The directions prompt you to connect your USB GPS to the system and then to follow the 

default selections for installing the USB drivers. 
ix) Click Finish on the Completing Setup Wizard window. 
x) Click the “X” on the upper right of the Installation window to close the Installer. 
xi) Re-boot your computer to activate the USB drivers. 

c) Watch the Training Videos listed on the CD and also check out the website for the latest training 
videos and information at www.anywheremap.com/videos. 
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2. STARTING AnywhereMap XP or AnywhereWX XP FOR THE FIRST TIME 
 
An AnywhereMap icon should be located on your desktop as a 
result of the installation process named “AWXP”. Double-click it 
to open the program.  If not, click Start, All Programs, look for 
the AnywhereMap folder, then click AnywhereMap XP.  
 
The first time the software is run you will see the window at right 
appear.  Into this entry box you must enter the product 
activation code that inside the CD case.  Carefully enter the 
serial number located on the sticker in the CD case. This is 
case sensitive and the last letter is ALWAYS capital. (So “I” is 
capital i, not small L.) 
 
Having entered a valid ID code, the software will start when OK 
is clicked.  You will never need to do this step again, however 
this screen is available for your review in the Help menu of the 
application. 
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3. SETTING UP A GPS 
 
NOTE: If you have a Motion tablet computer, you may want to watch the training 
video that describes the Bluetooth connection process. 
www.anywheremap.com/videos 
 
Most new systems use wireless GPS receivers that transfer data to the computer via the 
Bluetooth communication protocol. These GPSs may still have power cord that keeps 
their internal battery charged while flying, but the data they broadcast is sent to the computer (and 
subsequently to AnywhereXP software) via a Bluetooth radio transmission. In order to use a Bluetooth 
GPS, your computer must have Bluetooth capability with internally or via the addition of an adapter that is 
inserted into the PCMCIA or Compact Flash slot, depending on which your computer has available. The 
GPS10 that we supply with our systems is shown at upper right. 
 
Other GPSs connect to the computer directly using a wire that plugs into the USB 
(Universal Serial Bus) connector port. Our Tracker USB GPS is shown at right. 
When you install AnywhereXP, the USB driver (software in the computer that lets 
the Tracker USB GPS talk to the computer’s operating system). These deices are 
also powered by the computer through the USB port as well. 
 
Bluetooth GPS Set Up 
 
All computers are different and therefore it’s difficult to show one way to make Bluetooth connections. But 
there are some general steps we can describe that should help you get connected. 
 
1. Make sure AnywhereXP is NOT running. If it is, click the red “x” in the upper right corner to close it. 
2. If your computer does not have Bluetooth internally, then purchase a Bluetooth adapter that will work 

with one of the adapter slots your computer has, and follow the directions for installing that device. 
3. If your computer does have Bluetooth internally (or once you have finished installing the 

Bluetooth adapter described above) then open the Bluetooth Manager software to prepare for 
the GPS set up. You may find a Bluetooth icon in your system tray in the lower right corner of 
your display that looks something like the icon at right. 

4. Look for the button or check box that allows you to turn on the Bluetooth radio. Without this turned on, 
you will not be able to connect to any wireless devices. 

5. Turn on your GPS. For the GPS10, press the power button on top of the unit until a blue light begins 
flashing. It will flash about twice per second when it is powered on but NOT connected. 

6. Your Bluetooth Manager software should give you the option to Create a new connection with a 
button that says something like “New”, “New Connection”, etc. 

7. Once clicked, the system will search the airwaves for Bluetooth devices in range. Once the search is 
complete it should list the wireless devices that it found. The GPS should be listed – in our case it will 
list GPS10. 

8. Click once on the GPS10 listing, then click Next (or similar) to proceed.  
9. In most cases, the connection will be set up automatically. Toward the end the status progress 

window will list the COM port to which the device (the GPS) has been assigned. Remember this 
number or write it down. You’ll need it the next time your run AnywhereXP. 

10. In some cases the software may ask for a code for the GPS. If you have the GPS10 from us, use the 
code 1234. Then proceed with the default responses for a Bluetooth device set up until it is complete. 

11. Once complete, close the Bluetooth Manager. 
12. Start AnywhereXP. 
13. Make sure the GPS is turned on. If possible, put the GPS outside 

where it can see satellites. Be careful to not place the GPS more 
than 30-40 feet from the computer and make sure windows are 
nearby. Otherwise the Bluetooth signal may not reach between the 
two units. 

14. Click the menu Settings, then GPS Settings. The window at right 
will appear.  
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15. Click the arrow on the right side of the COM Port box to open the list. Select the COM port that the 
Bluetooth Manager assigned when you created the connection in the previous steps. Leave the rest 
of the settings as they are. 

16. Click OK. 
17. The flashing blue light on the GPS10 should flash about 5 times in fast succession, then begin a slow 

flash, once every 2 seconds. This is your indication that the GPS is connected to the computer.  
 
If the GPS is outside and if you have the Flight Info overlay window open (see Overlay Windows) you 
should see 0 knots, your approximate GPS altitude, and the number of satellites the GPS currently has 
locked. If the GPS is inside, you should see 0 knots and NoSat. If the connection has not been made to 
the GPS, you will see NoGPS. If the proper COM port has not been set, you’ll see NoComm in the lower 
pane of the Flight Info. 
 
Tracker USB GPS Set up 
 
It is important that you do NOT connect the Tracker USB GPS before installing our software on the 
computer.  If the Tracker GPS was installed prematurely, windows will connect the wrong device driver to 
the Tracker and it may require a call to Tech support to resolve this issue.   
 
Before calling Tech support, you should check our online Knowledge Base for any information on the 
Tracker USB or other problems you may be having.  There are many useful tips and tricks in the 
knowledge base and it is available 24/7. 
 
To use the software with the Tracker USB, simply run Anywhere XP and plug in the GPS to the USB port 
on the computer.   Windows should automatically detect the GPS and configure it.   You still have to tell 
the Anywhere XP software which GPS to use.  This need only be done once and is accomplished by 
selecting Setup GPS from the File Menu. 
 
If more than one COM port is listed in the Com Port dropdown list, select the TIUMP USB serial port (this 
name may vary on Windows 98 and ME).  Select 4800 for the Baud rate, and Click OK.   If the GPS is 
working properly, within a few seconds the NoGPS flag in the Flight info box, will change to NoSat, 
indicating that data is being received from the GPS, but that the GPS does not yet know where it is 
located.  Once the GPS knows the location, the NoSAT message will turn into a display of the number of 
satellites being used.  If the GPS is unplugged or loses the signal, NoSat or NoGPS will re-appear in a 
few seconds. 
 
If you are using another GPS, connect the GPS to the tablet / Laptop according to the manufacturer’s 
installation instructions before AWXP is started.  Select that GPS from the drop down list provided in GPS 
Setup. 
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4. SETTING UP XM WEATHER 
 
NOTE 1: These instructions assume the XM receiver is already activated. If you bought it from us, 
it has been activated even if you did not buy a complete system from us.  
 
NOTE 2: You MUST have DC power to perform this set up. The XM unit draws MORE than 1 amp of 
current and therefore many AC/DC converters WILL NOT RUN the XM unit properly. If you do not 
have enough power, the XM unit may not connect or operate properly even though it appears the 
power is fine.  
 
NOTE 3: If you have a Motion tablet computer, you may want to watch the training video that 
describes the Bluetooth connection process. www.anywheremap.com/videos 
 
1) If it is running, close AnywhereXP software. 
 
2) Connect the DC power plug to the XM receiver by gently inserting the silver metal plug end of the 

power cable into the receptacle located on the XM receiver labeled “Power”. You MUST have power 
to the XM receiver for it to operate, even if you are using a laptop and USB connection. The USB 
connection will NOT supply power for the XM unit! 

 
3) Plug the small XM antenna into the XM receiver using the pink end on the antenna and inserting it 

into the right-most connector that is labeled “RF In”. Place the antenna in clear view of the southern 
sky and while it may work inside, outside is best for a strong connection. 

 
4) Insert the power plug into the car/aircraft cigarette lighter plug. There are two LED lights on the XM 

radio. One is on the upper front edge just above the word “WxWorx”. It should be alternating between 
red and green. The second light is on top of the XM radio between the red/green LED and the top 
center of the unit. It should be flashing blue. 

 
5) If you have a Bluetooth (BT) XM radio, then follow the steps under this section number 5. If you are 

using the USB wired connection for the XM radio, then skip to section number 6 below. 
a) Make sure the XM unit is powered and that the antenna has FULL and UNOBSTRUCTED view of 

the high southern sky. 
b) Start your BT Manager software and begin creating a connection just the way you did for the 

GPS. 
c) The XM radio will be called “XM BLUE” in the list after the search for BT devices is complete. 
d) You will need a passcode for the XM radio. When prompted, use the numeral 0 as the passcode. 
e) At some point the BT Manager should tell you it is creating a modem connection on COM [x]. 

Make sure you record the COM port that is being assigned to the XM connection. 
f) During the connection set up process, the computer will connect to the XM radio. You will know 

this has happened when the red/green light changes to solid green and the flashing blue light 
changes to solid blue. 

g) Near the end of the connection setup, the connection will be broken once again. This is normal. 
h) Once completed, close the BT Manager. 
i) Start AnywhereXP. 
j) Click on the menu Settings, then XM Weather Settings. The 

window shown at right will open. 
k) Open the COM port drop-down box and select the COM port 

assigned during XM radio BT setup. 
l) Check the “Enable XM Weather” box. 
m) Make sure the weather products associated with your XM plan 

(Aviator Lite or Aviator) are checked on and then click OK. 
n) It will take several seconds for the window to close. In doing so, 

the connection to the XM radio will be made and the red/green 
light will change to solid green and the flashing blue light will 
change to solid blue. 
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o) If you have the Weather Info overlay displayed, you will see the status change from INIT to 
REQST to GOOD. This lets you know you have a good connection to the XM radio and also a 
good satellite signal. 

p) Refer to the Weather Information chapter to get more information about how the XM weather 
works, how long you should wait for it to display after start-up, etc. 

 
6) For the USB connected XM radio do the following substeps. 

a) Insert the USB cable into the port on the XM receiver labeled “Data” and the other end into a USB 
port of your computer. The computer should “see” the XM receiver and pop up a box that shows 
“new USB device detected” or similar message.  

b) If the computer does not, then leave the USB cable connected, close the software and restart it. 
This allows the software to see that the XM box is connected and ready for use. 

c) Start the AnywhereXP software, click on the Settings menu, then on XM Weather Settings. This 
opens the XM Weather Screen (see right) and allows you to specify how the XM receiver will be 
connected to your computer and also what weather products you’d like displayed.  

d) Drop down the Communications Port box and select the proper port for the XM box connection. 
This will most likely be the Communications Port USB selection. 

e) Click the check box for Enable XM and also on the products you want to have displayed. These 
can also be toggled on and off using toolbar icons on the map screen. Click OK. 

f) The green LED on the upper front of the XM receiver should illuminate.   
 
Your XM radio is now configured. 
 
Make sure you check www.anywheremap.com/support for our knowledge base articles that may help 
troubleshoot XM set before you call our tech support line. Do not call XM for support. 
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5. CONFIGURING THE WEATHER DISPLAY 
 
AnywhereXP Weather will display weather data derived from two networks: The XM WX Satellite network 
and the AnywhereLink Internet.  
 
XM versus AnywhereLink 
 
XM is a continuous broadcast of weather data files that requires the XM WX radio for operation. 
Depending on the subscription plan you have, the NEXRAD (radar), METARs, TAFs, etc are received 
directly into the computer and displayed on the AnywhereMap presentation.  
 
AnywhereLink is a request-reply network that accesses data files that are on our servers in Kansas. 
When your computer is connected to the Internet (such as over a wifi or other network when you’re NOT 
in the airplane) you can retrieve weather data files that are similar to those received over the XM network. 
This is handy for flight planning, etc. and eliminates the need to take the entire XM system out of the 
plane to access weather for those tasks. 
 
You must have a subscription for each service in order to receive weather data from them. This chapter 
describes general weather product control. For specific information about each network, see the 
applicable chapter. 
 
IMPORTANT: If you are using XM, do NOT use the toolbar icons that have the arrows underneath unless 
you have an AnywhereLink subscription and are specifically intending to use it! Using these toolbar icons 
disables XM reception and you must specifically turn it back on. 
 
Controlling the weather display 
 
The following icons control various weather capabilities in AnywhereWx XP. 
 
This is the Weather toolbar:  
 
 
If you are using the XM weather feed, the system continuously sends weather data to the computer. You 
simply toggle the products on and off the display as required using the TOGGLE icons. See table below. 
 
If you are not connected to the XM system but you have an Internet connection or you are using the 
Globalstar satellite connection, you must request weather data from the servers each time you want it. 
This is done using the “download” icons. See table below. 
 

 

Toggles radar (NEXRAD) data on and off. 

 

Toggles light precipitation on and off. 

 

Toggles radar looping on and off. Looping steps through the last several radar 
images and puts them “into motion” showing movement, growth and decay, etc. 

 

Toggles satellite imagery on and off. (not available on XM feed) 

 

Toggles lightning on and off. 

 

Toggles METAR / TAF graphics on and off. 
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Opens the Wx Set Up screen for configuring AnywhereLink. DISABLES XM! 

 

Retrieves radar (NEXRAD) across Globalstar or AnywhereLink. DISABLES XM! 

 

Retrieves satellite imagery across Globalstar or AnywhereLink. DISABLES XM! 

 

Retrieves the weather products checked in the Wx Set Up screen all at one time. 
DISABLES XM! 

 
 
 
6. CONFIGURING ANYWHERE LINK 
 
AnywhereLink is an additional subscription available from Control Vision that allows you to access 
weather products directly over an Internet connection instead of using your XM of Globalstar network that 
you use while in flight. This allows you to plan flights on the Anywhere XP software almost anywhere. 
 
To configure AnywhereLink, click View, then Wx Settings. You MUST enter your subscriber username in 
the Weather Username box at the bottom left. Then, simply click on the various weather products that you 
wish to see listed. Once configured, simply press the icon that applies to the weather product you want to 
download. This assumes you have an Internet connection. 
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7. SETTING UP THE MAP DISPLAY 
 
The new version of AnywhereMap XP (Map only or Map/Wx) has 
tremendous flexibility in map presentation. We provide six map 
presentations, each of which can be customized to your specific flying 
requirements and preferences. These map configurations are called 
Views. 
 
To open the View Setup window, simply click View, then View 
Settings or, if a keyboard is attached, press the letter “s”. The window 
at right shows the initial View window which shows the Navigation tab. 
A series of check boxes is there to allow displaying or hiding the 
various navigation items. 

 
The same holds true for each subsequent tab seen in this window. 
Each contains and series of checkboxes that allow you to specify which 
items to show on the map and which to hide. 
 
Once you have a configuration to your liking, tap on the View Setup 
tab (see image at right) to save these settings and name the map 
configuration in a way that makes it easy for you to remember how it is 
configured. In the example at right, View 1 is being renamed VFR view 
and probably has airspaces turned on, airways off, and perhaps terrain 
turned on. 
 
 
 
9. SETTING UP AN AIRCRAFT PROFILE 
 
Let’s begin by profiling the aircraft we are flying, a Beechcraft A36TC 
Bonanza. In that way we’ll have meaningful flight planning results, 
anticipate our fuel consumption and time in the air, and provide a glide 
ratio for Cones of Safety to draw safety nets around airports along our 
route.  
 
Click Settings, then Aircraft Settings and fill out the information 
boxes for your aircraft.  
 
Enter Fuel Consumption and performance data from your Pilots 
Operating Handbook. Cones of Safety establishes a glide ratio and 
can use any two values that result in a ratio. For example, if you know your aircraft has a 7:1 glide ratio, 
enter 7 miles and 5300 ft. to establish that ratio.  Use your aircraft’s tail number and make and model for 
ID. Remember to type in a reasonable interval in the Tank Reminder window. This prompts you from the 
screen to switch fuel tanks and keep your in-flight load balanced. Click Save to store this profile. Click 
Load to view a list of previously stored profiles, select one and load it.  
 
A word of caution about Cones of Safety: Be conservative in establishing a glide ratio; your POH was 
written for a new airplane. Also remember that the Cone is drawn without regard for prevailing winds, so 
gliding from a downwind position will result in a necessarily longer glide with greater loss of altitude. 
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Weight and Balance 
 
Click the Weight and Balance button found at the right side of the 
Aircraft Profile window. This opens a window that allows entry of 
weight and balance data for the aircraft whose profile is being entered 
in the Aircraft Settings window.  
  
Click the check box labeled “Lock Arm Values” to unlock the arm data 
values and open them for entry. See the example at right. Using your 
POH, enter the proper values for the arm lengths of each position 
described by the label. For example, if the arm length associated with 
the Pilot station is 43 inches, then enter 43 in the Arm column across 
from the Pilot. 
 
To add flexibility you can use other positions in place of those listed. 
For example, in the case of a three row, six seat aircraft such as the 
Bonanza you can use Pilot to be BOTH front passengers, Pax 1 for 
both middle passengers, and Pax 2 for the rear seat row. What ever 
arm lengths you use sets the position for the weight you enter later as 
you load the airplane. 
 
Once the arms are entered for the stations, re-check the “Lock Arm 
Values” box to lock them. This way, you only enter weights for each 
flight in this airplane. See the new example at right. 
 
Now enter the weights associated with this specific flight. When you’re 
done, click OK.  
 
 
 
 
You are now left at the Aircraft Settings window where you’re 
ready to Save this aircraft profile. Click Save. This opens the 
Save Profile window and allows you to give the profile a name. 
We suggest the tail number of the aircraft.  
 
There is no limit to the number of aircraft profiles that you can 
create and save.  
 
To load a saved profile, simply open the Aircraft Settings window 
and then click Load. Select the aircraft profile to load and click 
Open. The profile is now loaded and ready to use. 
 
NOTE: After loading a new profile, don’t forget to set the weights for the flight you’re about to take! 
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8. ANYWHEREMAP XP BASICS 
 
These are a few concepts that will make using AXP (map or weather) simpler. 
 
1. Airport Lookup 
 
There are two ways to look up information for a specific airport (or any item for that matter): 
 
a. Double-tap the airport (item) that you see on the map, or 
b. Use the associated look up symbol (airport, navaid, waypoint, or universal). 
 
For example, to retrieve airport information for Kansas City International, tap the airport lookup 
symbol (same symbol as used on a sectional chart). A window opens that lists all kinds of 
information about the airport. 
 
As you can see from the example at right, there are tabs on the left edge 
of the Airport Information window that break the data into categories: 
basic airport data, communication, airport data (like the AFD), FBO data 
(from www.100LL.com), fuel prices (from www.100LL.com), hotel and 
restaurant information (from www.Hotels.com) and approaches (currently 
only the non-precision approaches and the virtual ILS are available). 
 
At the bottom of this window you’ll find the map orientation and flight 
planning selection buttons.  
 
“Jump To” repositions the map to the airport (or any other item) 
described in the window. 
 
“Waypoint / Fly To” adds the item into the flight plan. (See flight planning 
for more information) 
 
“Done” closes the window and leaves the map positioned where it was when you looked up this 
information. 
 
2. Navaid / Fix / Waypoint Lookup 
 
In the same way that airport information can be retrieved as described in item 1 above, navaids, fixes, 
and waypoints can also be retrieved. See the following symbols. 
 
Navaid / Fix Lookup:  Waypoint Lookup:  

 
3. Universal Finder 
 
The Universal Finder allows you to retrieve information about all 
navigation items under one symbol. It also is a very powerful tool for 
quickly finding items thrown at you by ATC. Clearance changes are a 
perfect example. They generally start with you going direct to some fix 
you can’t spell. The universal finder makes it quick and easy to find 
these obscure items without spelling them out all the way. 
 
When ever you begin entering information in the universal finder entry 
window, a list that conforms to the entry is generated saving you time 
and frustration.



AnywhereMap XP (and Wx) User Manual 2.0 Page 15 Copyright Control Vision® 2005 

 
 
9. FLIGHT PLANNING MADE EASY 
 
Flight planning is simple and straight forward. To keep it simple, 
always plan using the following steps: 
1. Create a “Direct To Destination” flight plan from the departure 

airport. 
2. Add the waypoints in the order in which they will be 

encountered. 
 
A. Direct To Destination 
 
Example: Flight from PTS to MCI 
 
Aircraft is located at PTS, Pittsburg, KS. We are flying to Kansas 
City International. 
 
 
 
 
Click on the Airport Search Tool (or Universal Finder). In the window 
that appears, type in the ICAO code and the airport’s identifier. If you do 
not know the identifier, type in the airport name. If you’re using the 
software in the US, you do not need to use the K in the ICAO box. 
Simply enter the three-digit identifier in the box and tap OK. 
 
 
The airport information window opens for you to verify that this is the 
airport to which you want to fly. Once verified, tap Wpt/Fly To. 
 
 
 
 
 
 
 
 
 
A single-waypoint flight plan is now activate direct to Kansas City. 
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B. Add Waypoints 
 
Just like the airport lookup, you can select any navigation items in 
either of the same two ways: double-tapping the map on the item or 
using the associated lookup icon in the toolbar. 
 
Example: Add BUM VOR as a waypoint. 
 
Double-tap the VOR icon for BUM, the Butler VOR. 
 
 
 
 
 
 
 
 
 
 
 
 
The VOR Information Window opens and shows you the details on the 
navaid. 
 
Tap Wpt/FlyTo. 
 
 
 
 
 
 
A new window opens that gives you control over the order in which this 
item (BUM  VOR) will fit into the existing flight plan.  
 
a. You can make BUM the new destination, removing MCI all together by 
tapping “Fly Direct To”. 
b. You can make BUM the next waypoint (the one you will fly to from your 
current position) by tapping “As Next Waypoint”. 
c. You can add BUM to the flight plan based on its sequence along the line 
from departure to destination by tapping “As a Waypoint”. This is the one 
you would normally use. Do NOT use “As next waypoint” unless you truly 
want to got to the waypoint you’re adding from your current position. In 
almost all cases, you will use “As a waypoint”. 
d. You can make BUM the final destination and fly there AFTER you fly to 
MCI by tapping “As Final Waypoint”. 
 
 
 
 
Continue adding waypoints in the same fashion, by tapping them on the map or looking them up using the 
icons. 
 
Refer to the website and training videos for more information on flight planning and other features of 
AnywhereMap XP. Also, AnywhereMap for the PDA works the same way and many features document 
there work the same way with this software. 
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C. Reviewing the Flight Plan 
 
Tap the Flight Plan icon to open the Flight Plan Manifest. This shows the entire plan and allows 
changes, saving, loading, and setting up of VNAV to waypoints in the flight plan. 
 
The Flight Plan Manifest (right) is arranged by 
Leg number, Waypoint Name, Course, Heading, 
Distance, Ground Speed [calculated] and ETE 
[calculated]. In the example, we added a wind 
vector (16 kts at 160 degrees), reflected in the final 
calculation. Tip: On your return trip from Davis, 
load this flight plan and tap the Reverse button to 
flop the flight plan. 
 
To save this flight plan, go to File > Save Flight 
Plan F11. Name the plan something that reflects 
the origin and destination like PTS 2 MCI.   
 
 
 
 
 
 
 
ROUTE WIZARD 
 
Sometimes it is more practical to write out a flight plan 
than to build one graphically, leg by leg. Anywhere XP’s 
Route Wizard uses a simple shorthand to sketch out the 
elements of a flight plan. Tap on the Route Wizard 
Button <show> (or go to View > Route Wizard R) (or 
simply type R).  
In this example we will create a flight plan from KHMT 
(Hemet Ryan Airport) to KRIR (Flabob Airport) by way of 
Homeland VOR (HDF) and LEHNO Fix. 
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10. USING THE WEATHER SOFTWARE 
 
A. Available Weather Products – XM WX and AnywhereLink 
 
The following weather products are available for display on the AnywhereMap XP using XM WX and 
AnywhereLink: 
 
Weather Product Accessed Via Description Udate Freq 
NEXRAD (radar) XM, G*, AWLink Graphical, 7 color 5 mins 
METAR/TAF XM, G*, AWLink Text and graphical depictions 12 mins 
Echo Tops XM Graphical, shades of gray 12 mins 
Satellite IR XM, G*, AWLink Graphical, shades of gray XM: 12 mins, G*/Link: 1 hr 
Lightning XM, G*, AWLink Graphical, lightning bolts 5 mins 
Winds Aloft Fcst XM Graphical 12 mins 
Storm Cell Track XM Graphical / Text 1.25 mins 
 
AnywhereWx for XP can access weather via the XM WX weather gear and also via the Internet using a 
subscription (priced separately) to AnywhereLink. When you activate the AnywhereLink connection, the 
XM connection is disabled and you must re-enable it when you get in the airplane.  
 
B. Timing and receipt of weather product updates 
 
XM Weather 
 
XM is a continuous broadcast of the weather data to the XM radio in the airplane. The data is broadcast 
to the airplane in individual computer files, one for each weather product (i.e. a radar file, lightning file, 
etc.). The broadcast is serial, that is, one file at a time. Therefore, the files are sent on a schedule that 
keeps the weather data current but also allows many difference files to be sent. 
 
The broadcast schedule is shown in the table above. This important to know because after you turn on 
your system and see the GOOD status in the WX Info box, it can still take several minutes before any 
weather data is displayed. Many customers make the mistake of pressing buttons to “get the weather”. 
This is not applicable to the XM broadcast operation and will further delay getting weather displayed. 
Simply follow the start up procedures, verify you have a GOOD signal, and then go about your taxi and 
departure duties. In most cases you will see radar and other weather products long before you actually 
depart. 
 
AnywhereLink and Globalstar 
 
These systems use request/reply instead of continuous broadcast. Therefore, you initiate the weather 
retrieval by pressing an icon or button on the iPAQ (or tablet) and then the current files are sent to the 
iPAQ from the server on the ground via the Globalstar satellite phone or the AnywhereLink (via wifi, cell 
phone, Internet connection, etc.) 
 
The data is sent in individual computer files just like XM but you can select which weather products to 
retrieve and when to get them. The files are updated on our servers on a regular basis so you can be 
sure that each time you retrieve them, you’re getting the latest available. 
 
The server update schedule is approximately as follows: 

• NEXRAD (radar): updated every 5 minutes 
• IR sat photo: updated once per hour 
• METARs/TAFs: updated once per hour 
• Lightning: Update once per minute 
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NEXRAD Off NEXRAD On

C. Sequence of Display on AnywhereMap 
 
The sequence of display on the map is important to understand because some information can obscure 
other information, depending on the intensity of the weather conditions, map zoom level, etc. (See below 
for an example of how NEXRAD overlays satellite imagery). The order that the AnywhereMap “paints” the 
weather products, from first to last (on top) is: 

1. Echo Tops or IR Sat Image 
2. NEXRAD 
3. Lightning (slowly cycles on and off) 
4. METAR/TAF Flags 

 
The reason it’s important to know this is 
because, for example, there are times when 
there is so much lightning activity that the 
lightning strike graphics can actually obscure 
the NEXRAD graphics since lightning is painted 
on top of NEXRAD. (That’s a whopper of a 
storm!) So it is useful to turn the lightning off 
(that’s also why we flash it on and off) so you 
can see the NEXRAD radar presentation un-
obscured by the lightning. To see the complete 
echo top presentation, you need to turn off 
NEXRAD (radar), and so on. 
 
 
 
 
D. Turning weather products on and off 
 
Generally a pilot wants to see radar (NEXRAD), which is the color-
coded Doppler radar presentation, and so you’ll normally want that 
product turned on for display. However, there are other weather 
products that can clutter the screen and are not useful depending 
on weather conditions. There are two places to control weather 
product display. 
 
Via Toolbar Icons 
 
The tool bar contains the icons for turning weather products on 
and off. You can control NEXRAD, METARs/TAFs, Echo Tops / IR 
Sat, Light Precip, Lightning, and Radar Looping. 
 
IMPORTANT! If you see tool bar icons that are weather related 
that also have blue arrows protruding from the bottoms of the 
graphics, these are AnywhereLink icons and will initiate weather 
retrieval over an Internet link (requires a separate subscription) Pressing them will also disable XM 
weather connections and at least, cause some head-scratching. Please do not use these toolbar icons 
unless you specifically choose AnywhereLink. 
 
Via Settings 

a. Tap File > Settings > XM Weather 
b. Notice the check boxes. Turn the weather product displays on or of using these check 

boxes.  
c. Also see “Views” for information on how to save weather settings as part of a user 

defined view. 
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E. Weather Products in Detail 
 

1. NEXRAD (Radar): This is the same color-coded precipitation view that is commonly seen on TV 
and Internet weather sites. The levels of color (least intense < blue, dark green, yellow, orange, 
red, magenta and white > most intense) denote the levels of precipitation intensity as measured 
by a network of Doppler weather radar systems across the lower 48 states. Since Doppler radars 
see not only precipitation but also precipitation intensity based on turbulence, the color-coding 
provides excellent information for pilots to decide where to fly and where not to fly. From our 
experience, we can simplify your enroute weather avoidance decision-making by providing the 
following advice: 

a. The NEXRAD file is a static, composite “snapshot” of the entire US radar that is updated 
every 5 minutes and sent to the AnywhereMap system every 5 minutes. It is very 
accurate since nearly every spot in the US is looked upon by at least two Doppler radars. 
So the others surrounding it generally cancel the attenuation that can occur with any 
individual radar. The NEXRAD presentation is very accurate but remember: it is a static 
snapshot! That means the actual conditions can be different! Use the presentation to 
determine where you WON’T fly, and circumnavigate those areas by a large 
margin. The goal is to complete a trip that you wouldn’t otherwise take, not do it in the 
fastest time! 

b. Do NOT fly in any yellow color area unless you are POSITIVE that the precipitation is 
associated with non-convective activity. If it’s convective, give yellow areas a berth of at 
least 10 and even better, 20+ miles. We aren’t kidding here folks.  

c. It might go without saying, but we’ll say it anyway: DO NOT fly anywhere near any red, 
magenta, or white color radar tiles! THERE ISN’T ANY SITUATION WHERE THESE 
COLOR TILES DENOTE ANYTHING OTHER THAN SEVERE, AIRFRAME BUSTING 
CONDITIONS. DON’T DO IT. DON’T EVEN GET NEAR THEM. This isn’t our lawyer 
talking; this is one group of pilots telling another. If you get near these areas, you’re going 
to get hurt. 

d. Areas of lighter precipitation can be flown through as long as you keep the following in 
mind: if it’s cold, you might get ice, REALLY FAST. If it’s convective, these areas can still 
be very turbulent and can turn into nasty conditions very quickly. 

e. “Clear” areas between cells can be flown through with the following in mind: you are in a 
convective situation. You need to know if conditions are building or diminishing. If 
building, the space between the cells can close before you get through. Remember, all 
Datalink NEXRAD systems have a delay of several minutes from real time. Come visit us 
in Kansas next May if you want to see the difference 5 minutes makes in thunderstorm 
development! If the area in which you’re flying is IMC and the cells are embedded, the 
space between the cells should be wide – like more than 30 miles – or don’t go through 
go around. If you’re VMC, then compare what you see out the window with what’s on the 
AnywhereMap. Finally, if one gap is closing, others are too. Make SURE you have a way 
out. Forward is not the only direction the aircraft can go. 

f. If you use AnywhereLink, there are two lower levels of light precip below the blue on XM 
NEXRAD: “dithered” blue and “dithered” green. These show very light precip and can be 
handy when the air is very cold (you might get ice) and to denote virga (you might get 
bounced around a bit). 

2. Echo Tops (XM only): Echo tops are the highest (in altitude) radar echo returns in each 1 mile 
square area, color coded in shades of gray from dark (a low top) to light (a high top). Echo tops 
are easily confused with satellite imagery of clouds. A stratus cloud that has no precip and no 
turbulence will not even show on an echo top presentation. A cloud can actually be much thicker 
(and have a higher top) that the echo top shows. The easiest way to differentiate them is to 
remember: echo tops are created by radar and cloud images are created by satellite imagery 
(pictures). Echo tops normally mean more to the high altitude guys than those of us down low. 
And since NEXRAD is painted on top of echo tops (on AnywhereMap) most of the time you won’t 
even see the echo top presentation unless you turn off NEXRAD. However, there can be 
instances where the echo top is helpful down low. For example, you might be skirting around 
some individual cells at night. You might be avoiding the NEXRAD areas but decide to fly through 
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a few of the echo top areas that protrude out from under the NEXRAD. Be aware that these areas 
are lead in areas to the cells. There isn’t enough activity for NEXRAD to pick it up, but radar still 
sees something. You would be wise to either go around, or tighten your belts. 

3. IR Sat Photo: The sat image is a satellite picture; color coded to 
cloud tops and is truly the tops of the clouds, within a thousand feet 
or so. Below 12,000 feet msl the colors break every 3,000 feet. 
Above 12,000’ there are only three additional color breaks. See the 
diagram at right for details and a very cool example of the sat image 
from a winter low-pressure system. For most general aviation aircraft 
that fly below 12,000’, the sat photo is most useful to locate areas of 
clouds versus clear areas and also to estimate the tops of the 
overcast on cold days (i.e. can I get on top and out of the cold 
clouds?) 

4. Light Precip: To de-clutter the screen and only show the nasty stuff, 
you can turn off the light precip colors. Be aware that if you turn it off, 
you can possibly miss seeing some areas that are developing in a 
convective situation.  

5. METAR/TAF: This is the pesky text-based data that is provided by 
larger airports, some airports with ASOS/AWOS and also forecasts 
from NWS. They come to AnywhereMap via text files and we place 
the text under the airport information screens for their associated 
airports. Since we hate having to read the things for basic 
information like ceilings and visibilities, we also convert these two data 
values to a graphic that displays on the map. 

a. When “turned on” the METAR flags show on the map next to the 
airport that generated the data. The flag (see diagram) is split 
diagonally – the upper left corner is the ceiling and the lower right is 
visibility.  

b. They are each color coded to VFR/IFR conditions and are 
independent of one another. Consequently, you can see at a glance 
whether the observed conditions for ceiling and visibility at an airport 
are VFR (white), marginal VFR (yellow), IFR (red), or low IFR 
(purple). 

c. If a TAF (forecast) has been received for that airport, 
a small square is attached to the upper left corner of 
the METAR flag. Since the TAF covers a time period, 
there is no graphic that represents data values like 
the METAR. Therefore, you have to look under the 
associated airport information screen to see the TAF 
text. 

d. If you want to see the basic METAR text, simply 
single-tap the METAR flag. A box will pop up that 
shows the basic METAR info such as shown at right. 

e. If you want to see all details of the METAR and the 
TAF data, simply double-tap the airport symbol for 
which the MEATR flag is associated. Then tap the 
WX tab. The METAR is decoded at the top for easier 
reading (do you remember all the METAR 
precipitation codes???) and the complete coded METAR is just below. If a TAF was 
received for that airport, the TAF is below that and can be accessed by scrolling down. 

f. METAR/TAF info is received on the XM link for entire US while in flight about every 12 
minutes. You will be amazed at the increased safety and pro-active flight management 
that can be done when you have this data updated continuously while enroute. Unless 
weather conditions are changing very rapidly (like a cold front, or fog forming) there is no 
reason to be surprised by the weather at your destination or your fuel stop. You can 
watch it the entire time you’re in flight! 
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g. To see the weather at ANY airport while enroute, regardless of if that airport is displayed 
on the map at the time, simply tap the airport icon (bottom toolbar) and then tap in the 
airport identifier. Then tap the WX tab. You can read the latest conditions for that airport 
without even seeing it on the map. Once again, the ability to pro-actively make 
destination, fuel stop, and fuel management decisions enroute is truly fantastic! 

6. Winds Aloft (XM Only): When turned on, you’ll see blue wind barbs in a grid on the map that uses 
the standard convention for direction and velocity. You can select the altitude for which the 
forecast wind barbs are shown or select “Follow Altitude” so the barbs represent the forecast at 
your current altitude. 

7. Storm Cell Tracking (SCIT, XM Only): When a large thunderstorm cell is present and you zoom in 
to a close range, you’ll see green dots inside the cell areas. Each dot represents one storm cell. If 
you tap the dot, the cell information will appear in a pop up box for a short time. The information 
includes cell identification number, direction of movement, velocity, tops, precip (hail, etc.) and 
even shear values (for rotation). Obviously, if there is an SCIT icon in the cell, it’s a significant cell 
and you should give it a VERY wide berth. 

8. XM Signal Q: Sets the weather age number in the upper left corner of the screen to alternate with 
the quality of the XM signal as seen by the XM antenna. Useful just as a quick check of XM signal 
quality. 

9. Lightning: Turns lightning on or off. The lightning file is static just like all the rest and shows cloud 
to ground strikes for the entire US. It is sent to the AnywhereMap system every 5 minutes, just 
prior to the NEXRAD file being set. 

 
 
Installation Guide Updates 
 
Please check our website as new versions of XP are released along with associated release notes and 
videos on how to operate the software. www.anywheremap.com/videos 
 
NOTE: Not all features in AnywhereMap for Pocket PC are in AnywhereMap XP. Many of these 
features will be added through time. 
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